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1. Sicherheitshinweise  
 

Dieses Gerät erfüllt die EU-Bestimmungen 2014/30/EU (elektromagnetische 
Kompatibilität) entsprechend der Festlegung im Nachtrag 2014/32/EU (CE-
Zeichen). 
Vor Inbetriebnahme der Geräte sollte die  Bedienungsanleitung sorgfältig gelesen 
werden. Nachfolgend aufgeführte Sicherheitshinweise zum Betrieb der Geräte 
unbedingt beachten. Schäden, die durch Nichtbeachtung dieser Hinweise 
entstehen, sind von Ansprüchen jeglicher Art ausgeschlossen: 
 
* Warnhinweise am Gerät unbedingt beachten. 
* Gerät keinen extremen Temperaturen, direkter Sonneneinstrahlung, extremer 

Luftfeuchtigkeit oder Nässe aussetzen. 
* Starke Erschütterungen vermeiden 
* Gerät nicht in der Nähe starker magnetischer Felder (Motoren, 

Transformatoren usw.) betreiben 
* Heiße Lötpistolen aus der unmittelbaren Nähe des Gerätes fernhalten 
* Vor Aufnahme des Messbetriebes sollte das Gerät auf die 

Umgebungstemperatur stabilisiert sein. 

* Ersetzen Sie die Batterie, sobald das Batteriesymbol " " leuchtet. 
Mangelnde Batteriespannung kann unpräzise Messergebnisse hervorrufen.  

* Sollten Sie das Gerät für einen längeren Zeitraum nicht benutzen, entnehmen 
Sie die Batterie aus dem Batteriefach. 

* Säubern Sie das Gehäuse regelmäßig mit einem feuchten Stofftuch und 
einem milden Reinigungsmittel. Benutzen Sie keine ätzenden Scheuermittel. 

* Vermeiden Sie jegliche Nähe zu explosiven und entflammbaren Stoffen. 
* keine technischen Veränderungen am Gerät vornehmen 
* Öffnen des Gerätes für Wartungs- und Reparaturarbeiten dürfen nur von 

qualifizierten Service-Technikern durchgeführt werden. 
*     Messgeräte gehören nicht in Kinderhände ! 
 
Reinigung des Gerätes 

Gerät nur mit einem feuchten, fusselfreien Tuch reinigen. Nur handelsübliche 
Spülmittel verwenden. Beim Reinigen unbedingt darauf achten, dass keine 
Flüssigkeit in das Innere des Gerätes gelangt. Dies könnte zu einem Kurzschluss 
und zur Zerstörung des Gerätes führen. 
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2. Einführung 
 
Diese Serie von Datenloggern für Lufttemperatur, Luftfeuchtigkeit (P 5185); 
Gleichspannung von 0 bis 30V (P 5186) und Temperaturmessungen über Typ-K 
Fühler (P 5187) überzeugt durch seine lange Aufnahmedauer genauen 
Aufnahmedatum und Zeitpunkt, wobei 32000 Messwerte im internen Speicher 
abgelegt und anschließend über USB abgerufen werden können. 

 
 
 
 
 

3. Technische Merkmale 
  
► Datenlogger mit internem Speicher bis zu 32.000 Messwerten  
► Mehrzeilige LCD Anzeige mit Warn-LEDs  
► Messrate von 10 Sekunden bis zu 12 Stunden  
► Auswechselbare 1/2 AA 3,6 V Lithium-Batterie  
► Aufnahmezeit von bis zu 2 Jahren möglich 
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4. Bedienelemente und Anschlüsse am Gerät 
 
P 5185: 
 

 
 

1 Leer 

2 Funktionstaste zum Starten und Stoppen des Aufzeichnungsvorgangs 

3 LCD-Anzeige 

4 Status LED 

5 LED-Anzeige bei niedriger Batteriespannung 

6 USB-Steckanschluss 

7 Externer Sensor zur Messung der Temperatur und Luftfeuchtigkeit 
(Messkopf: ca. 6 mm Durchmesser) 
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P 5186: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 Schraubklemmen für Spannungsmessung 

2 Funktionstaste zum Starten und Stoppen des Aufzeichnungsvorgangs 

3 LCD-Anzeige 

4 Status LED 

5 LED-Anzeige bei niedriger Batteriespannung 

6 USB-Steckanschluss 
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P 5187: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 Eingang für Typ-K Temperaturfühler 

2 Funktionstaste zum Starten und Stoppen des Aufzeichnungsvorgangs 

3 LCD-Anzeige 

4 Status LED 

5 LED-Anzeige bei niedriger Batteriespannung 

6 USB-Steckanschluss 
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4.1. Symbole in der Anzeige 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Zeigt die Maßeinheit des angezeigten Messwertes an. 
2. Messwert wird angezeigt. 

3. „ “-Symbolanzeige bedeutet, dass ein Teil der aufgezeichneten Messungen 
überschreiten den oberen Grenzwert. 

4. „ “-Symbolanzeige bedeutet, dass ein Teil der aufgezeichneten Messungen 
überschreiten den unteren Grenzwert. 

5. Die Anzeige wechselt je nach Ladezustand von  zu . Eine leere 
Batterie sollte umgehend erneuert werden. 

6. LOG-Symbol wird angezeigt, sobald der Logging-Modus aktiv ist und 
Messwerte aufgezeichnet werden. 

7. Es wird der Kanal angegeben, dessen aktuelle Messwerte angezeigt werden. 
 

HINWEIS:  

Das LCD funktioniert nicht bei unter -10°C. 
Für weitere Informationen zu der Software können Sie das Hilfe-Menü innerhalb der  
Software nutzen. 
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5. Installation 
 
5.1. Batterie einlegen 
 
Um den Datenlogger in Betrieb zu nehmen, muss zuerst die 3,6V Lithium Batterie 
eingelegt werden. 
 

    
 

  
 
Hinweis: 

Achten Sie darauf, diesen Anschluss 
mit dem Gehäuseteil auszurichten,  
wenn Sie das Gerät wieder aufsetzen. 
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5.2. Software Installation 
 
Um den Datenlogger in Betrieb zu nehmen, muss zuerst die PC-Software von der 
beiliegenden CD installiert werden.  
 
Legen Sie hierzu die beiliegende Software-CD in das CD/DVD-Laufwerk Ihres PC’s 
ein. 
Wenn das Programm nicht automatisch ausgeführt wird, führen Sie einen 
Doppelklick der Datei „Setup.exe“ aus und installieren Sie das Programm in einen 
beliebigen Ordner auf Ihrer Festplatte. 
 
Folgen Sie den Bildschirmanweisungen, um die Installation abzuschließen. 
Es wird ein neues Symbol „Datenlogger Graph“ auf dem Desktop angezeigt.  
 
Bitte beachten Sie, dass Sie den USB-Treiber nach Abschluss der Software-
Installation installieren müssen, um die Datenlogger-Software verwenden zu 
können. 
 
 
 

5.3. Installation des USB-Treibers 
 
Nach Abschluss der Software-Installation, stellen Sie sicher, dass die Software-CD 
in Ihren CD/DVD-ROM-Laufwerk Ihres PC’s eingelegt ist. 
 
Doppelklick auf die Datei "USBXpressInstaller.exe" im Verzeichnis „Treiber“ auf der 
CD, um mit der Installation zu beginnen. 
 
Folgen Sie den Bildschirmanweisungen, um die Installation des USB-Treibers 
abzuschließen.  
Sie können nun den Datenlogger in einen freien USB-Anschluss Ihres PC’s 
einstecken.  
Einen Moment später wird Ihr Computer die Meldung ausgeben, dass die Treiber 
für den Datenlogger vollständig installiert wurden und das Gerät nun verwendet 
werden kann. 
 
Nun, haben Sie erfolgreich die erforderliche Software und USB-Treiber für Ihren 
Datenlogger installiert. 
 
Hinweis:  
Das Gerät kann nur in Verbindung mit der Software genutzt werden und wird nicht 
als externer Datenträger erkannt. 
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6. Bedienung 
 
6.1. Einstellungen vor der Anwendung 
 
Um den Datenlogger zu verwenden, gehen Sie folgendermaßen vor: 
 
1. Stellen Sie sicher, dass der Akku richtig eingesetzt wurde. 
2. Stecken Sie den Datenlogger in einen freien USB-Port Ihres PC‘s, auf dem  

die Data Logger Graph Software und die zugehörigen Treiber installiert sind. 
3. Doppelklicken Sie auf das Symbol "Datenlogger Graph" auf Ihrem Windows-

Desktop. Dadurch wird die Datenlogger Graph Software gestartet. An der 
linken oberen Seite des Software-Fensters befindet sich die Schaltfläche 
"Start". Klicken Sie darauf, um das Dialogfeld "Data Logger Device" zu öffnen. 

4. Wählen Sie den aktuellen Datenlogger aus. Hier können Sie die Firmware-
Version, Status, etc. des ausgewählten Datenloggers überprüfen. 

5. Klicken Sie auf die Schaltfläche "Setup" um das Dialogfeld "Data Logger 
Setup" zu öffnen. Folgen Sie den Bildschirmanweisungen, um Ihren 
Datenlogger einzurichten und Einstellungen vorzunehmen. In der 
Registerkarte "General" können Sie Ihren Datenlogger benennen und die 
Messrate einstellen. In der Registerkarte "Channel Settings" können Sie die  
oberen/unteren Grenzwerte festlegen und Alarmeinstellungen vornehmen. In 
der Registerkarte "Start und Stop-Method“ können Sie die festlegen, wie der 
Datenlogger die Aufzeichnung beginnen bzw. beenden soll. Der Datenlogger 
ist beim ersten Start der Software auf Standardwerte voreingestellt. 

6. Klicken Sie auf die Schaltfläche "Finish". Der Datenlogger wird gemäß Ihren 
Einstellungen starten. 

7. Entfernen Sie den Datenlogger vom USB-Anschlusses Ihres PC.  
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6.2. Auswerten des Datenloggers 
 

Schließen Sie den Datenlogger an Ihren PC an und starten Sie die "Datenlogger 
Graph" Software. 
 

1. Stecken Sie den Datenlogger in einen freien USB-Port Ihres PC‘s, auf 
dem  die Data Logger Graph Software und die zugehörigen Treiber 
installiert sind. 

 
2. Doppelklicken Sie auf das Symbol "Datenlogger Graph" auf Ihrem 

Windows-Desktop. Dadurch wird die Datenlogger Graph Software 
gestartet. An der linken oberen Seite des Software-Fensters befindet 
sich die Schaltfläche "Start". Klicken Sie darauf, um das Dialogfeld 
"Data Logger Device" zu öffnen. 

 
3. Wählen Sie den aktuellen Datenlogger aus. Hier können Sie die 

Firmware-Version, Status, etc. des ausgewählten Datenloggers 
überprüfen. 

 
4. Klicken Sie auf die Schaltfläche "Download" auf dem Dialog "DATA 

LOGGER DEVICE". Hier können Sie die Bildschirmanweisungen zum 
Herunterladen und Speichern der Daten auf Ihren PC folgen.  

 
5. Ist der Download abgeschlossen, wird die Meldung "Download 

finished“ (Download beendet)  angezeigt und Sie können mit der 
Schaltfläche "Öffnen" die heruntergeladenen Daten grafisch darstellen 
lassen. 
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6.3. Auswerten der Messdaten mit einem Kurvendiagramm 
 
1. Doppelklicken Sie auf das Symbol "Datenlogger Graph" auf Ihrem Windows-

Desktop, um die Datenlogger Graph Software zu starten. 
 
2. Über das Menü "Datei  Öffnen" können Sie eine Datenlogger-Datei (* .dlg, * 

.mdlg) öffnen und das Kurvendiagramm anzeigen lassen. 
 
3. Vergrößern (Zoom In):  

a. Klicken Sie mit der Maus innerhalb des Diagrammbereiches und 
ziehen Sie einen Rahmen, um den gewünschten Bereich zu 
vergrößern.  

b. Verkleinern (Zoom Out):  
Klicken Sie auf "Undo Last" oder "Undo All" in der Werkzeugleiste, um 
das letzte Kurvendiagramm oder das ursprüngliche Diagramm 
anzeigen zu lassen. 

 
4. Pan: Halten Sie die mittlere Maustaste gedrückt. Nun können Sie das 

Kurvendiagramm frei bewegen/positionieren und im Diagrammbereich 
verschieben. 

 
5. Zoom und Pan-Methode: 

Auto: Zoom und Pan in eine beliebige Richtung.  
Horizontal: Zoomen und schwenken nur in horizontaler Richtung.  
Vertikal: Zoomen und schwenken nur in vertikaler Richtung.  

 
6. Markieren von Datenpunkten:  

Klicken Sie mit der rechten Maustaste auf einen Punkt das Kurvendiagramms.  
Ein Pop-Up-Menü wird angezeigt. Klicken Sie nun auf "Label Data Point", um 
den ausgewählt Punkt zu markieren. 

 
7. Graph Settings: Klicken Sie mit der rechten Maustaste auf den Diagramm-

Bereich und ein Popup-Menü wird angezeigt. Klicken Sie auf "Graph-Settings", 
um das Dialogfeld „Graph Settings“ aufzurufen. Hier können Farbe, Schriftart, 
Größe und Zeileneinheit für das Diagramm festgelegt werden. 

 
 

7. Datei exportieren 
Die Software speichert und öffnet Dateien des Typs *.dlg oder *.mdlg 
standardmäßig.  
Mit „Save as…" im Menü „File“ können Sie zwischen verschiedenen Dateitypen 
auswählen: *.dlg; *.mdlg; *.txt; *.csv; *.xls; *.bmp und *.jpg 
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8. Drucken 
Um den Graphen, Statistiken und Datentabelle drucken, klicken Sie auf das 
Druckersymbol auf Standard-Werkzeugleiste oder wählen Sie "Drucken" aus dem 
"File" im Pulldown-Menü. 
Benutzer können auch auf das "Datei-> Drucken und Exportoptionen" wählen Sie 
die gedruckten Inhalte der folgende Dialog. 
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keine LED blinkt 

Datenlogger befindet sich im Ruhezustand, die Batterie ist erschöpft 
oder  es ist keine Batterie eingebaut.1 

 

LED blinkt grün alle 10 s 

Der Datenlogger befindet sich aktuell im Aufzeichnungsmodus. 

 

Beide LEDs blinken grün alle 10s 
Der Datenlogger wird ab dem vom Benutzer voreingestellten Datum - 
und Zeit mit der Protokollierung beginnen oder es soll daran erinnert 
werden, dass der Benutzer die Taste zum Starten drückt. 
 

Beide LEDs blinken grün alle 60s 

Der Datenlogger hat die vom Benutzer voreingestellte Protokollierung 
beendet und  die Aufzeichnung angehalten. 

 

LED blinkt rot alle 10s 
Der Datenlogger befindet sich aktuell im Aufzeichnungsmodus. 
Der Alarm-Modus (High / low / oder beide) auf einem Kanal ist 
aktiviert.4 

 

Beide LEDs blinken rot alle 60s 
Der Datenlogger hat die vom Benutzer voreingestellte Protokollierung 
beendet und angehalten.  
Alarm (hoch, niedrig oder beides) auf mindestens einem Kanal ist 
aktiviert. 
Hinweis:  
Dieser Zustand tritt nur auf, wenn Alarm-Hold aktiviert ist. 

 

LED blinkt gelb alle 60s 
Anzeige für niedrige Batteriespannung. Die Protokollierung wird 
fortsetzt, jedoch sollte die Batterie baldmöglichst überprüft und ersetzt 
werden. 
LED blinkt gelb alle 1s 
Zeigt an, dass einen USB-Verbindung besteht. 

 

Abwechselnd blinkt eine LED gelb und die Andere grün 

Batterie ist installiert und das Gerät kann verwendet werden. 

 

Abwechselnd blinkt eine LED gelbe und die Andere rot 
Batterie ist installiert, jedoch kann das Gerät nicht gestartet werden. 

 

1. Batteriestatus kann über den Data Logger Gerätedialog in der Datenlogger 
Graph-Software überprüft werden. Selbst wenn der Akku leer ist, gehen die 
aufgezeichneten Daten nicht verloren. 

2. Start und Stop-Methode kann über den Data Logger Setup-Dialogfeld in der 
Datenlogger Graph Software eingestellt werden. 

3. Rote Alarm-LED für jeden Kanal und grüne LED-Statusanzeige kann über den 
Data Logger Setup-Dialogfeld in der Datenlogger Graph Software für Strom 
sparen deaktiviert werden. 

4. Wenn Alarm-Hold aktiviert ist, wird die rote LED blinken, sobald die Messwerte 
die eingestellte Alarmgrenze überschritten haben und 
auch wenn die Messwerte in den normalen Bereich wieder zurückkehren. Dies 
sorgt dafür, dass Sie immer wissen, wenn die Alarmgrenze überschritten 
wurde. 
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9. Funktionstaste 
Der Datalogger verfügt nur über eine Funktionstaste. Die jeweilige Funktion ist 
abhängig davon, in welchem Modus sich der Datalogger zu dem Zeitpunkt befindet: 
Wenn Sie über das Data Logger Setup-Dialogfeld in der Datenlogger Graph-
Software den Start der Protokollierung durch Tastendruck wählen, können Sie 
durch drücken und gedrückt halten der Funktionstaste (bis die grüne LED leuchtet) 
die Protokollierung starten. 
 
Wenn Sie über das Data Logger Setup-Dialogfeld in der Datenlogger Graph-
Software auswählen, dass Sie vorhandene Daten überschreiben möchten, wenn 
der Datenlogger die Protokollierung aufgrund von erschöpften Speicher gestoppt 
hat, können Sie durch drücken und gedrückt halten der Funktionstaste (bis die 
grüne LED leuchtet) die Protokollierung stoppen. 
 
Wenn Sie über das Data Logger Setup-Dialogfeld in der Datenlogger Graph-
Software den LED Alarm (obere und untere Grenzwerte festgelegt) eingestellt und 
aktiviert haben und somit bei Über – bzw. Unterschreitung die rote LED bei Alarm 
blinkt, können Sie durch drücken und gedrückt halten der Funktionstaste (bis die 
rote LED leuchtet), den LED Alarm zurückzusetzen. 
 

 
So erhalten Sie korrekte Messergebnisse 
 
Vor Beginn einer Aufzeichnung sollten Sie die Batteriekapazität überprüfen.  
Beachten Sie beim Einsatz des Datenloggers die spezifizierten 
Umgebungstemperaturen und Luftfeuchtigkeitswerte, um korrekte Messergebnisse 
zu erhalten. 
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10. Technische Daten 
 
Allgemein: 

Speicher 64k Bytes (32.000 Messwerte) 

Messrate 
einstellbar von 10 Sekunden bis 12 
Stunden 

Messung starten 
Sofort; Start durch Tastendruck; Start nach 
Zeit/Datum-Voreinstellung 

Messung stoppen  
Messung stoppt, wenn Speicher erschöpft 
Messung stoppt, wenn voreingestellter 
Messpunkt erreicht wurde 

LED-Anzeige 

Rote & grüne LED 
Statusanzeige des Datenloggers: 
Umfasst die Verzögerung des Startes der 
Messung, Anzeige bei Aufzeichnung von 
Messwerten (Logging), Alarm und 
Messung beendet 
 
Mit Hilfe der Software können diese 
beiden LED’s deaktiviert werden, um die 
Batteriespannung zu sparen. 
 
Gelbe LED 
Anzeige bei niedriger Batteriespannung 

Länge Sensor Länge der Messleitung: 3 Meter 

Schutzart IP 20 

Batterie ½ AA 3.6V Lithium-Batterie 1200mAh 

Batterie- 
einsatzdauer 

Bis zu 2 Jahren abhängig von der 
Einstellung der Messrate und der LED-
Anzeige  

Betriebstemperatur 20°C, ± 5°C 

Abmessungen (BxHxT) 38 × 122 × 22 mm   

Gewicht 60g 
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PeakTech® 5185 
 

Kanäle 
2 Kanal-Datalogger: 
Kanal 1: Luftfeuchte RH% 
Kanal 2: Temperatur 

 
Relative Luftfeuchtigkeit (RH%) 

Messbereich Auflösung Genauigkeit 

0 … 100% 0,1% RH ±3,0% RH 

 
Lufttemperatur 

Messbereich Auflösung Genauigkeit 

-40 …125°C  0,1°C ±0,3°C 

(-40 …257°F) 0,1°F ±0,5°F 

 
 
 
PeakTech® 5186 
 
Gleichspannung (DCV) 

Messbereich Auflösung Genauigkeit 

0 … 30V DC 0,01V +/- 1,0% v.M. + 6 Stellen 

 
 
 
PeakTech® 5187 
 
Temperatur-Eingänge Typ-K 

Messbereich Auflösung Genauigkeit 

-200 … 1300°C 0,1°C ± 0.5°C 

-328 … 2372°F 0,2°F ± 0.9°F 
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11. Auswechseln der Batterie 
 

Bei Aufleuchten des -Symbols muss die Batterie gewechselt werden. 
Öffnen Sie das Gerät wie in Abschnitt 5.1 beschrieben und entfernen Sie die 
verbrauchte Batterie und setzen eine neue gleichen Typs ein (3,6V Li-Batterie). 
Verbrauchte Batterien sind Sondermüll und müssen in die dafür vorgesehenen 
Sammelbehälter gegeben werden. 
 
Nehmen Sie das Gerät nie in Betrieb, wenn es nicht völlig geschlossen ist. 
 
Hinweis:  

1. Halten Sie das Gerät trocken.  
2. Halten Sie die Sonden sauber.  
3. Bewahren Sie das Gerät außerhalb der Reichweite von Kindern auf.  

4. Wenn das Symbol "  " erscheint, ist die Batterie leer und sollte 
schnellstmöglich ersetzt werden. Wenn Sie eine Batterie einsetzen, achten Sie 
auf korrekte Polarität der Batterie. Wenn Sie das Gerät für einen längeren 
Zeitraum nicht benötigen, entfernen Sie die Batterie aus dem Gerät. 

 
11.1. Hinweise zum Batteriegesetz 
 
Im Lieferumfang vieler Geräte befinden sich Batterien, die z. B. zum Betrieb von 
Fernbedienungen dienen. Auch in den Geräten selbst können Batterien oder Akkus 
fest eingebaut sein. Im Zusammenhang mit dem Vertrieb  dieser Batterien oder 
Akkus sind wir als Importeur gemäß Batterieverordnung verpflichtet, unsere 
Kunden auf folgendes hinzuweisen: 
 

Bitte entsorgen Sie Altbatterien, wie vom Gesetzgeber 
vorgeschrieben- die Entsorgung im Hausmüll ist laut 
Batterieverordnung ausdrücklich verboten-, an einer kommunalen 
Sammelstelle oder geben Sie sie im Handel vor Ort kostenlos ab. 
Von uns erhaltene Batterien können Sie nach Gebrauch bei uns 
unter der auf der letzten Seite angegeben Adresse unentgeltlich 
zurückgeben oder ausreichend frankiert per Post an uns 
zurücksenden. 

 

Schadstoffhaltige Batterien sind mit einem Zeichen, bestehend aus einer 
durchgestrichenen Mülltonne und dem chemischen Symbol (Cd, Hg oder Pb) 
des für die Einstufung als schadstoffhaltig ausschlaggebenden 
Schwermetalls versehen: „CD“ für Cadmium, „Pb“ steht für Blei und „Hg“ für 
Quecksilber. 
 
 
 
 

 
 



-18- 

Alle Rechte, auch die der Übersetzung, des Nachdruckes und der Vervielfältigung 
oder Teilen daraus, vorbehalten. Reproduktionen jeder Art (Fotokopie, Mikrofilm 
oder ein anderes Verfahren) nur mit schriftlicher Genehmigung des Herausgebers 
gestattet. 
 
Letzter Stand bei Drucklegung. Technische Änderungen des Gerätes, welche dem 
Fortschritt dienen, vorbehalten. 
Druckfehler und Irrtümer vorbehalten. 
 
Hiermit bestätigen wir, dass alle Geräte die in unseren Unterlagen genannten 
Spezifikationen erfüllen und werkseitig kalibriert geliefert werden. 
 
Eine Wiederholung der Kalibrierung nach Ablauf von einem Jahr wird empfohlen. 
 
© PeakTech®  
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1. Safety precautions 
 
This product complies with the requirements of the following European 
Community Directives: 2014/30/EU (Electromagnetic Compatibility)) as 
amended by 2014/32/EU (CE-Marking). 
 
The following safety precautions must be observed before operation. 
Damages resulting from failure to observe these safety precautions are 
exempt from any legal claims whatever: 
 
* Comply with the warning labels and other info on the equipment. 
* Do not subject the equipment to direct sunlight or extreme temperatures, 

humidity or dampness. 
* Do not subject the equipment to shocks or strong vibrations. 
* Do not operate the equipment near strong magnetic fields (motors, 

transformers etc.). 
* Keep hot soldering irons or guns away from the equipment. 
* Allow the equipment to stabilize at room temperature before taking up 

measurement (important for exact measurements). 
* Replace the battery as soon as the battery indicator “ ” appears. With 

a low battery, the meter might produce false reading. 
* Fetch out the battery when the meter will not be used for long period. 
* Periodically wipe the cabinet with a damp cloth and mid detergent. Do 

not use abrasives or solvents. 
* Do not store the meter in a place of explosive, inflammable substances. 

* Do not modify the meter in any way. 
* Opening the equipment and service- and repair work must only be 

performed by qualified service personnel. 
* Measuring instruments don’t belong to children hands. 
 
Cleaning the cabinet 
Clean only with a damp, soft cloth and a commercially available mild 
householder cleanser. Ensure that no water gets inside the equipment to 
prevent possible shorts and damage to the equipment. 
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2. Introduction 
 
This series of data loggers for temperature, humidity (P 5185); DC voltage from 0 to 
30V (P 5186) and temperature measurements via type K probe (P 5187) convinces 
by its long recording time exact recording date and time, with 32 000 readings in 
internal memory and then can be accessed via USB. 
 
 
 
 
 

3. Technical features 
 
► Data logger with internal memory up to 32.000 readings 
► Multi-line LCD display with warning LEDs 
► measuring rate from 10 seconds up to 12 hours 
► Replaceable 1/2 AA 3.6V lithium battery 
► recording time up to 2 years possible 
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4. Panel description 
 
P 5185: 
 

 
 

1 Empty 

2 Function switch to start and stop of the logging process 

3 LCD-Display 

4 Status LED 

5 LED-Display if battery is low 

6 USB-Port 

7 External sensor for measuring Temperature & Humidity (RH%) (Measuring 
head: approx. 6 mm diameter) 
 

 

1 

2 
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3 
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P 5186: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 Terminals for voltage measurement 

2 Function switch to start and stop of the logging process 

3 LCD-Display 

4 Status LED 

5 LED-Display if battery is low 

6 USB-Port 
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P 5187: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 Input for type-K temperature sensor 

2 Function switch to start and stop of the logging process 

3 LCD-Display 

4 Status LED 

5 LED-Display if battery is low 

6 USB-Port 
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4.1. Symbols in the display 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Indicates the unit of the displayed value. 
2. Shows the actual measurement value. 

3. „ “-symbol means that a part of the recorded measurements exceed the upper 
limit. 

4. „ “-symbol means that a part of the recorded measurements exceed the lower 
limit value. 

5. The display changes depending on state of charge from  to  . An 
empty battery should be replaced immediately. 

6. LOG icon is displayed when the logging mode is active and readings are 
recorded. 

7. It is stated the channel whose current readings are displayed. 
 

NOTE: 

The LCD does not work below -10 °C. 
For more information about the software you can use the Help menu within the 
software. 
 

 

7 
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5. Installation 
 
5.1. Insert the battery 
 
To take the data logger into operation, the 3.6V lithium battery must be inserted at 
first. 

    
 

  
 
 
Note: 

Be sure to align this connection  
to the housing part, if you do it on again. 
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5.2. Software Installation 
 
To take the data logger into operation, the PC software must be installed from the 
CD first. 
 
Please insert the software CD into the CD / DVD drive of your PC. If the program 
does not run automatically, double click the "setup.exe" file and install it in any 
folder on your hard drive. 
 
Follow the onscreen instructions to complete the installation. 
It appears a new symbol "Datalogger Graph" on the desktop. 
 
Please note that you must install the USB drivers after installing the software in 
order to use the Data Logger software. 
 
 
 

5.3. Installing the USB driver 
 
After completing the software installation, make sure that the software CD is 
inserted into your CD / DVD-ROM drive of your PC. 
 
Double-click on the file "USBXpressInstaller.exe" in the folder "Driver" on the CD to 
begin the installation. 
 
Follow the onscreen instructions to complete the installation of the USB driver. 
You can now plug the data logger into a free USB port of your PC. 
A moment later, your computer will display a message that the driver for the data 
loggers were fully installed and the device can be used now. 
 
Now, you have successfully installed the required software and USB drivers for 
your data logger. 
 
Note: 
The device can be used only in conjunction with the Software and is not recognized 
as an external hard disk. 
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6. Operation 
 
6.1. Settings before use 
 
To use the data logger, proceed as follows: 
 

1. Make sure the battery is inserted correctly. 
2. Plug the data logger into a free USB port of your PC, on which the 

datalogger Graph software and drivers are installed. 
3. Double-click on the icon "Datalogger Graph" on your Windows desktop 

to start the datalogger Graph software. In the upper left side of the 
software window the "Start" button is located. Click it to open the dialog 
box "Device Data Logger". 

4. Select the current datalogger. You can check the firmware version, 
status, etc. of the selected data logger. 

5. Click the tab "Setup" to display the "Data Logger Setup". Follow the 
onscreen instructions to set up your data logger and adjust settings. In 
the "General" tab, you can rename your data logger and set the 
measuring rate. In the "Channel Settings" tab, you can set the upper / 
lower limits and alarm settings. In the "Start and Stop Method" tab you 
can specify how the data logger should start or stop recording. The 
data logger is preset when you first start the software to the default 
values. 

6. Click the "Finish" button. The data logger will start according to your 
settings. 

7. Remove the data logger from the USB port of your PC. 
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6.2. Evaluating the data logger 
 
Connect the data logger to your PC and start the "data logger graph" software. 
 

1. Insert the data logger into a free USB port of your PC, on which the 
datalogger Graph software and drivers are installed. 

 
2. Double-click on the icon "Datalogger Graph" on your Windows desktop 

to start the datalogger Graph software. In the upper left side of the 
software window the "Start" button is located. 

 
3. Select the current datalogger. You can check the firmware version, 

status, etc. of the selected data logger. 
 

4. Click on the "Download" button in the dialog "DATALOGGER DEVICE". 
You can follow the onscreen instructions to download and save the 
data to your PC.  

 
5. If the download is complete, the message "Download finished" 

(Download complete) will be displayed and you can display the "Open" 
button which downloaded data graphically. 
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6.3. Evaluation of the measurement data with a graph 
 

1. Double-click on the icon "Datalogger Graph" on your Windows desktop 
to start the datalogger Graph software. 
 

2. By using the menu "File  Open" you can open a data log file (*.dlg, 
*.mdlg) and display the graph. 
 

3. Zoom (Zoom In): 
a. Click the mouse inside the graph area and drag a box to zoom in 

the desired range. 
b. Zoom Out (Zoom Out): 

Click "Undo Last" or "Undo All" in the toolbar to display the last 
graph or the original diagram. 
 

4. Pan: Press and hold the middle mouse button. Now you can use the 
graph to move freely / position and move the graph area. 
 

5. Zoom and Pan Method: 
Auto: Zoom and Pan in any direction. 
Horizontal: Zoom and pan in horizontal direction only. 
Vertical: Zoom and pan in the vertical direction only. 

 
6. Mark of data points: 

Click with the right mouse button on a point of the curve diagram. A 
pop-up menu will appear. Now click on "Label Data Points" to mark the 
selected item. 
 

7. Graph Settings: Click the right mouse button on the chart area and a 
popup menu is displayed. Click on "Graph Settings" to open the dialog 
box "Graph Settings". Here you can specify color, font, size and line 
unit for the chart. 

 
 

7. Export File 
The software saves and opens files of type *.dlg or *.mdlg as default. 
With "Save as ..." from the "File" menu, you can choose between different file types: 
*.dlg; *.mdlg; *.txt; *.csv; *.xls; *.bmp and *.jpg. 
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8. Print 
To print the graphs, statistics and data table, click the printer icon on the standard 
toolbar or select "Print" from the "File" pull-down menu. 
Users can also click on the "File-> Print and Export options" to choose the printed 
contents of the following dialog. 
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No LED flashes 

Data logger is in idle state, the battery is exhausted or 
there is no battery installed.1 

 

LED flashes green every 10 s 

The data logger is currently in the recording mode. 

 

Both LEDs flash green every 10s 
The data logger will start the logging by Date – Time, which is 
predefined by the user or it should be recalled that the user presses 
the button to start. 
 

Both LEDs flash green every 60s 

The data logger has completed the preset logging by the user and 
stopped the recording. 

 

LED flashes red every 10s 
The data logger is currently in the recording mode. 
The Alarm Mode (High / Low / or both) on a channel is enabled.4 

 

Both LEDs flash red every 60s 

The data logger has completed the preset logging by the user and 
stopped. 
Alarm (high, low or both) on at least one channel is enabled. 
Note: 
This condition occurs only if the alarm Hold is enabled. 

 

LED flashes yellow every 60s 
Display for low battery voltage. The logging continues, however the 
battery should be checked and replaced as soon as possible. 
LED flashes yellow all 1s 

Indicates that an USB connection exists. 

 

Alternately one LED flashes yellow and the other green 
Battery is installed and the device can be used. 

 

Alternately one LED flashes yellow and the other red 

Battery is installed but the unit cannot start. 

 

1. Battery status can be checked via the Data Logger device dialog in the 
datalogger Graph software. Even if the battery is empty, the recorded data do 
not lost. 

2. Start and stop method can be set via the Data Logger Setup dialog box in the 
datalogger Graph software. 

3. Red alarm LED for each channel and green LED status indicator can be 
turned off to save battery on the Data Logger Setup dialog box in the 
datalogger Graph Software. 

4. If alarm Hold is activated, the red LED will flash once the readings have 
exceeded the preset alarm limit and even if the readings return to normal 
range. This ensures that you always know when the alarm limit has been 
exceeded. 
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9. Function key 
The datalogger has only one function key. The function depends on the mode in 
which the datalogger is located at the time: 
If you select via the Data Logger Setup dialog box in the datalogger Graph software 
to start logging by pressing a button, you can press and hold down the function key 
(until the green LED lights up) start logging. 
 
If you select from the Data Logger Setup dialog box in the datalogger Graph 
software that you want to overwrite existing data when the data logger has stopped 
logging due to depleted memory, you can press and hold down the function key 
(until the green LED lights) stop logging. 
 
If you have set on the Data Logger Setup dialog box in the datalogger Graph 
software the LED alarm set (upper and lower limits) and activated and thus the red 
LED flashes at increasing or decreasing of the set limits. 
You can press through and pressed hold the function key (to the red LED), the LED 
reset alarm. 
 
 
To obtain proper measurements 

 
Before starting a recording, you should check the battery capacity. 
Note to obtain the use of the data logger the specified ambient temperatures and 
humidity levels correct measurement results. 
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10. Technical Data 
 
General: 

Memory 64k Bytes (32.000 Measurement Values) 

Sample-Rate adjustable from 10 seconds to 12 hours 

Measurement Start 
Immediately; Start by pressing button; 
Start by pre-set of Time/Date 

Measurement Stop 
Measuring stops, if memory is full 
Measuring stops, when preset 
measurement point has been reached 

LED-Display 

Red and green LED 
Status display of the data logger: 
Includes the delay of the start of the 
measurement, display with recording of 
measured values (logging), alarm and 
measurement completed 
 
Using the software, these two LEDs can 
be turned off to save the battery voltage. 
 
Yellow LED 
Display low battery status 

Length of the sensor Length of the measuring line: 3 meters 

Protection class IP 20 

Battery ½ AA 3.6V Lithium-Battery 1200mAh 

Battery Life 
Up to 2 years depending on the setting of 
the measuring rate and the LED display 

Operating temperature 20°C, ± 5°C 

Dimensions (WxHxD) 38 × 122 × 22 mm   

Weight 60g 
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PeakTech® 5185 
 

Channels 
2 Channel-Datalogger: 
Channel 1: Humidity RH% 
Channel 2: Temperature 

 
Relative Humidity (RH%) 

Range Resolution Accuracy 

0 … 100% 0,1% RH ±3,0% RH 

 
Air -Temperature 

Range Resolution Accuracy 

-40 …125°C  0,1°C ±0,3°C 

(-40 …257°F) 0,1°F ±0,5°F 

 
 
 
PeakTech® 5186 
 
Voltage (DCV) 

Range Resolution Accuracy 

0 … 30V DC 0,01V +/- 1,0% of rdg. + 6 digits 

 
 
 
PeakTech® 5187 
 
Temperature – Input Type-K 

Range Resolution Accuracy 

-200 … 1300°C 0,1°C ± 0.5°C 

-328 … 2372°F 0,2°F ± 0.9°F 
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11. Battery Replacement 
 

If the  -Symbol appears in the display the battery should be replaced. 
Open the unit as described in section 5.1 and remove the old battery and put in a 
new one of the same type (3.6V Li-battery).  
Used batteries are hazardous waste and must be placed in the appropriate 
collection container. 
 
If the device is not completely closed, it should not be put into operation. 
 
Note: 

1. Keep the device dry. 
2. Hold the Sensors clean. 
3. Keep the unit out of reach of children. 

4. If the " " symbol appears, the battery is exhausted and should be replaced 
as soon as possible. If you are using a battery, pay attention to correct polarity 
of the battery. If you do not need the device for an extended period, remove 
the battery from the device. 

 
 
 
 

11.1. Notification about the Battery Regulation 

 
The delivery of many devices includes batteries, which for example serve to 
operate the remote control. There also could be batteries or accumulators built into 
the device itself. In connection with the sale of these batteries or accumulators, we 
are obliged under the Battery Regulations to notify our customers of the following: 

 
Please dispose of old batteries at a council collection 
point or return them to a local shop at no cost. The 
disposal in domestic refuse is strictly forbidden 
according to the Battery Regulations. You can return 
used batteries obtained from us at no charge at the 
address on the last side in this manual or by posting 
with sufficient stamps. 

 

Contaminated batteries shall be marked with a symbol consisting of a 
crossed-out refuse bin and the chemical symbol (Cd, Hg or Pb) of the heavy 
metal which is responsible for the classification as pollutant: „Cd“ for cadmium, 
„Pb“ stands for lead and „Hg“ for mercury. 
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All rights, also for translation, reprinting and copy of this manual or parts are reserved. 
 
Reproductions of all kinds (photocopy, microfilm or other) only by written permission of 
the publisher. 
 
This manual is according the latest technical knowing. Technical alterations reserved. 
Misprints and errors are reserved. 
 
We herewith confirm that the unit is calibrated by the factory according to the 
specifications as per the technical specifications. 
 
We recommend to calibrate the unit again, after one year. 
 
© PeakTech® 11/2021 Mi/Hr/Tw/Lie 
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